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R74 Summary Release Notes
This document contains summarized descriptions of enhancements for the specified release for all product lines. To view
more details, refer to the regular detailed release notes for each product line (HR, TLM, Scheduler, Payroll, Cross
Product).

Release Dates
A System Release will take place on the following dates and times for the following servers. System downtime for each
respective release can be expected during themaintenance windows:

•   EU Server: April 05, 2021 at 11:00pm - 3:30am BST

•   POD 60: April 06, 2021 at 11:30pm - 4:00am EDT

•   U.S. Server POD2: April 07, 2021 at 11:30pm - 4:00am EDT

•   U.S. Server POD5: April 21, 2021 at 11:30pm - 4:00am EDT

•   U.S. Server POD4: April 21, 2021 at 11:30pm - 4:00am EDT

•   U.S. Server POD3: April 22, 2021 at 11:30pm - 4:00am EDT

•   AUS Server: April 22, 2021 at 12:00am - 4:30am AEST

•   U.S. Server POD6: April 22, 2021 at 11:30pm – 4:00am EDT

Supported Operating Systems and Browsers
The following tables show the operating systems and browsers currently supported.

Note: All of these operating systems and browsers are supported, but somemay not be actively tested.

Platform OS Version
Desktop

Windows 10

Mac 10.13.4 (High Sierra)

Mobile

iOS 11.4.1 -> latest

Android 6.0.1-> latest

Browser Version
Internet Explorer 11

Microsoft Edge latest

Google Chrome latest

Mozilla Firefox latest

Safari latest
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Downloading Documents
UKG Ready Customers
Download release notes and user guides under:

• My Info > Help > Download Documentation

Partner Resellers
Download release notes and user guides under:

• Distribution > Tools > Download Documents
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TLM Enhancements
A summary list of the enhancements for the next system release is listed below. An in-depth explanation of these
descriptions is available in the regular detailed release notes. **For full details on any of the following enhancements,
including screen shots, please see the detailed TLM release notes for April 2021.**

   We are listening! Enhancements marked with the light bulb icon are a direct result of IDEAS submitted in
Community. Visit Community Ideas, upvote the best items, and keep the feedback coming!

Time Prep

NEW Time Prep (Mobile)
Time Prep has been converted to theMobile App. All general Time Prep functionality is the same, with the following new
features:

• The Time Prep process is adaptive to all screens, and all functionality can be performed on any device

• Processes are grouped by Type to more easily navigate Time Prep

• Steps will visually bemarked as completed via a visual task bar at the top of the screen so that users can identify
progress through the payroll process

• Mass Process Pay Periods

Payroll Metrics

Only for Australia: The following enhancement is currently available for Australian users.

Import Actual Hour Per Week if LSL Average Hours is Zero
WFR-211133: Previously, when transferring Payroll Metrics Leave Balance to UKG Ready, in some instances, the user
could choose not to use the Average Long Service Leave (LSL)Hours Per Week, which would result in all employees
incorrectly having an LSL value of 0 in UKG Ready.

What’s changed: If users choose not to use the Average LSL Hours Per Week in Payroll Metrics, the Actual Hours Per
Week value will bemultiplied by the number of weeks accrued and transferred into the employee’s Accrual balances in
UKG Ready.

Accruals 1.0

Only for Accruals 1.0: The following enhancement currently affects Accruals 1.0.
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Accruals 1.0: Default Time Off Balance Cards to Hours Instead of Days
WFR-184837: Previously, when both hours and days were configured to display in the Accrual Balances, the system
displayed theDay balance cards by default in the Time Off Balances cards page.

What’s changed:When hours and days are configured, theHour balance cards will display by default instead of theDay
balance cards.

Accruals 2.0

Only for Accruals 2.0: The following enhancements currently affect Accruals 2.0.

Accruals 2.0: Ability to Subtotal Accrual Balances Report 
WFR-186864: In Accruals 1.0, users can sum up all hours/days values and balance liability in report groups, as well as
allow for showing/exporting subtotals only. This is now available for Accruals 2.0.

Accruals 2.0: Custom Accrue: Fixed Grant and Tenure Based Grant Rules
WFR-80104, WFR-213974: Within the Fixed Grant and Tenure Based Grant Accruals rules, a new option, Custom Accrue
Period, is available. This gives you the ability to choose a custom accrue period.

Accruals 2.0: Monthly (Simple Schedule): Fixed Grant and Tenure Based Grant Rules
WFR-80103, WFR-213965: Within the Fixed Grant and Tenure Based Grant Accruals rules, from the Entitlement is
defined per drop-down, a new option is available,Monthly (Simple Schedule). You can then define the day of the grant
period, as well as enter a number of hours an employee will earn for each month during a calendar year.

Accruals 2.0: Prorated Calculated Based on Time Offs in Period
WFR-220679, WFR-220682, WFR-220687: In Days type time off Accruals policies, for Fixed Grant Rule: Proration, Tenured
Based Grant: Proration, and RTT Grant Rule, a new section has been added, Time Off Taken Proration, which will take
into account any time off taken within the Grant Period and prorate the grant the employee receives for that period.

InTouch

InTouch DX Update
WFR-229756: Firmware for InTouch DX clocks has been updated to version 1.2.0.143.

Leave of Absence

LOA Rule Now Allows 12-Month Period Measured Forward
WFR-212319: UKG Ready now accommodates the Department of Labor’s rolling 12-month forward leave period. A new
option, Use 12 Month Forward Measurement Period, has been added to the Leave of Absence Profile rule, Expire Leave
Time Taken. When enabled, the leave taken time balances will be tied to this 12-month forward measurement period.
After 12months from the first date that a specific leave type was taken, the balance will reset.
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Pay Calculations

Pay Calculations Profiles Rules Structure in Configuration Documents
WFR-209227, WFR-209223, WFR-209219, WFR-220965, WFR-220166, WFR-220155: For companies utilizing Pay
Calculations 2.0, users can download an easily understandable Configuration Summary document so that non-technical
audiences can digest the document. The following Pay Calculation rules now have a customized structure in the PDF
configuration document:

• Round All In/Out Time, Including Breaks and Lunches (v.2)

• Holiday Eligibility (v.2)

• Sum Up Time Off Hours By Day To Default Counter (v.2)

• Sum Up Time/Piecework By Day

• Distribute By Workday Breakdown

• Deduct Lunch (v.4)

Pay Calc 2.0: CA Double Time OT Not Calculating Correctly
WFR-222646: Previously, theNth Day Consecutive rule assigned all of an employee’s time on the nth consecutive day to
the Consecutive Day OT counter instead of splitting the time over the nth hour on the nth consecutive day between
Consecutive Day OT and Consecutive Day DT.

Going forward, the rule will now properly split time on the nth consecutive day between the Consecutive Day OT and
Consecutive Day DT counters based on what is configured in the rule.

Pay Calc 2.0: Exception Based on Lunch Not Applying Correctly

WFR-222656: Previously, when an employee entered two or more time entries, the Exception Based on Lunch rule
considered the total entered hours as opposed to processing the hours separately. This would cause a penalty for one
shift to be applied to each shift.

What’s changed:When there is a break in the day with two or more shifts, themeal penalty in the Exception Based on
Lunch rule will now process the hours separately.

Pay Calc 2.0: Floating 24 Hours OT Rule Not Allocating Hours
WFR-213761: Previously, when the Floating 24 Hours Overtime rule was used in conjunction with the Start All Cycles
Based On First Punch Of Pay Period setting within the rule, the system would not reference the first punch of the pay
period to determine a period start time. The rule would not allocate on the next time entry for timeworked within the 24-
hour period starting from the first In punch time.

Going forward, this newer version of the rule follows the setting to work as expected and the system will reference the
first punch of the pay period and apply overtimewhen an In punch occurs prior to this first In punch of the period.
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Pay Calc 2.0: Weekly OT Based on 32 in a Holiday Week
WFR-40632: Previously in theWeekly Overtime rule, there was no way to isolate holiday hours occurring in the week.

What’s been added: In the Assign Time Over section of the Weekly Overtime rule, a new field has been added, On A
Holiday Week,to define when overtime starts on a week that includes a holiday without having to include the holiday
granted hours into the weekly overtime.

Payroll Export Format

Payroll Export Hours with Comma H,00 Format Exported as H.00
WFR-182290: Previously, when exporting a payroll export with the time format and locales set with a comma decimal
separator, the export file exported as a point.

What’s been added: A new option, Use Decimal Separator Defined In Company Locale, has been added to Edit Payroll
Export Format. When enabled, the payroll export file will export with a comma decimal separator if configured in the
company Locale.

Updated iHCM Payroll Export Format to Support Half Day Absences

WFR-226289: For companies that need to import dynamic duration time off data and absences such as half day
absences into iHCM where there are no start and end times, a new option, Duration Based, has been added to the Time
Off record for the following columns:

• Half Day (column 28): Y will display if the pay record contains Half Day, First Half, or Second Half duration types,
otherwise it will display as blank.

• Scheduled Day Part (column 12): 1will display if the duration type in the pay record is Full Day, otherwise it will
display as blank.

• Day Part (column 17): 0.5 will display if the duration type in the pay record is First Half, Second Half, or Half Day,
otherwise it will display as blank.

• Start Day Part Code (column 26): S will display if the duration type in the pay record is First Half, otherwise it will
display as blank.

• End Day Part Code (column 27): E will display if the duration type in the pay record is Second Half, otherwise it will
display as blank.

Points

Category Update
WFR-228220: On the Points Balances report, users can now add Points without a Category. Previously, the Category field
was required.

Points Rule Did Not Trigger Correctly
WFR-121630: Previously, when points were configured using Late/Early Leave and set a list of excused time offs, when the
start/stop excused time off entry was used in combination with hours worked, the points rules triggered incorrectly.
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Going forward, points will be accrued in Late/Early Start and Late/Early Leave rules with excused time off. Points will not
accrue when users enter hours worked in combination with start/stop excused time off in all the views.

Reports

Split All Time Entries Report Views
WFR-211219: Previously, the Time Entries reports were only available from Current view > View By in the Approve Time
Entries report.

What’s changed: The Time Entries reports (All Time Entries, Approve Time Entries, and Time Entry To Do Items
Pending Approval) are now availableMenu items under Team > Time > Timesheets > Time Entries.

Split Change Requests Report Views
WFR-210516: Previously, the Change Requests reports were only available from Current view > View By in the
Timesheet Change Requests report.

What’s changed: The Change Requests reports (Timesheet Change Requests and Pending Timesheet Change Requests)
are now availableMenu items under Team > Time > Timesheets > Change Requests.

Time Off Roster: Added Visual Indicators for Approved and Pending TORs
WFR-199051: The cells in the Time Off Roster report will now display colors configured in the time off definitions. If a
dynamic duration is specified and you have the Time Off To Display filter options enabled, a circle icon will display in the
cell, such as a filled in circle to indicate a full day.

Timesheet

Important: All timesheet users will be switched to the New Timesheet view in R75 (June 2021).

ColumnWidths Now Dynamic

WFR-179052, WFR-226324: Previously, the Timesheet had fixed width columns, which would result in extra white
space horizontally.

What’s changed: The column widths are now dynamic, automatically adjusting to the size of the information it contains.
The From and To columns under the Time Entry tab will remain static, while the rest of the columns will size dynamically
so that the timesheet table fits in the entire screen.

Date on Calc Detail Tab is Now a Link
WFR-223645: As previously available in the Classic Timesheet, in the New Timesheet for desktop users, the date under the
Calc Detail tab is now a link that will navigate you to the Time Entry tab when clicked.

Display Schedules in Date Column

WFR-218083, WFR-218082: The Schedules column has been removed, and Schedules will now display in theDates
column underneath the date. The action column is next to theDates column. The schedules that will display are the raw
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schedules, not calculated. If you select the schedule, the Schedule/Shift Edit pop-up will display.

Expand/Collapse Timesheet Days Options

WFR-217292: Previously in the timesheet, users did not have the option to have all the days display as expanded rows
by default, expand the current day only, or to expand only the rows that contain data, such as punches or bulk hour
entries.

What’s new: You can now customize your timesheet viewwith the data that you want to initially see. In the Timesheet
Profile, a new drop-down, Expand Timesheet Days, has been added to the Extra Settings widget with the following
options to choose from:

• Expand Current Day And Days With Data Only

• Expand Current Day Only

• Expand Days With Data Only

• Expand All Days

Fixed “Date” and “Action” Columns to the Left and Moved Daily Totals (Start/End)
WFR-218292, WFR-218073: In the New Timesheet, theDate and Action columns under the Time Entry tab are now fixed
at the left of the timesheet and will remain fixed so that you can always see the data in these columns when you scroll.
Previously, these columns disappeared when users scrolled to the right.

In addition, the Daily Totals weremoved from above the days to below the days in order to improve the flow of time
information.

Re-Calculate/Save New Timesheet through Manage Exceptions
WFR-218322: Previously, when users made a change to exceptions on the timesheet via theManage Exceptions pop-up,
the timesheet would not re-calculate unless the user saved the timesheet or took another action to re-calculate.

Going forward, when an exception is modified/deleted/or added via theManage Exceptions pop-up, upon clicking Ok,
the timesheet will automatically re-save (re-calculate).

RenamedMy Clock to My Timesheet in Clock Widget

WFR-212294: The Clock widget link to a user’s timesheet that was previously labeled asMy Clock has been renamed
toMy Timesheet. In addition, in the Security Profile under theDashboards tab within theDashboard Widgets widget,
theMy Clock option has been renamed toMy Timesheet.

Separated Time Off and Cost Centers in Time Off Settings
WFR-160672, WFR-178548: Previously in the New Timesheet, users did not have the option from Time Off Settings to
separate the Time Off and Cost Centers columns, which was previously available in the Classic Timesheet.
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What’s been added: In the Timesheet Profile for the New Timesheet, an option from Time Off Settings is now available,
Separate Time Off and Cost Centers, which will separate these columns if enabled or combine them under one column if
disabled.

Updated Entering Military Time
WFR-201537: Previously, for companies with AM/PM enabled, when users entered a timewithout a colon, such as 207,
the system incorrectly interpreted it as military time and for this example, changed the time to 8:07 instead of 2:07.

Going forward, the system will interpret times correctly when entered in the timesheet.

Updated View on Time Entry Tab
WFR-221408: The Time Entry tab view on the on the timesheet has been updated and sizing improvements made in
order to fit more data, days, rows, and columns on the screen.

Timesheet Change Request

Added CC to Punch In Option

WFR-191024: Previously, if an employee forgot to punch in and was working in a new location or department, the
employee could not identify which cost center from Add Punch In Change Request they were working in, which resulted
in having to perform a separate action ofmodifying the cost center.

What’s changed: A Cost Center section has been added to Change Request for the type, Add Punch In. This allows
employees the option to choose the cost center for where the punch in should go when submitting this type of change
request.

Added Notification Tags for CC 6-9
WFR-192034: Previously, notification tags were only available in theGenerate Notification step of the Timesheet Change
Request workflow for cost centers 1-5.

What’s been added: Notification tags for cost centers 6-9 are now available to add. This will allow users to include up to 9
cost centers in an employee’s email notification.

Added Option for Delete Punch
WFR-211456: Previously, there was not a timesheet change request option for employees to request deleting a time
entry or single punch.

What’s been added: A new timesheet change request Change Type option has been added, Delete Time Entry. When
selected, the employee will be able to choose one or multiple time entries to delete.

Added Require Comment

WFR-191036: Previously, not all timesheet change request types had the option to require employees to add a
comment when submitting a timesheet change request.
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What’s been added: In the Timesheet Profile, within the Change Requests Employee Can Perform section, Require
Comment boxes have been added next to all change request types so that you can choose which timesheet change
requests should require a comment from the employee upon submission. 

Added Tag in Workflow Notification
WFR-192033: Previously in the Timesheet Change Request workflowGenerate Notification and Global Notification
steps, there were not any tags available to provide additional information.

What’s been added: A new tag, Request Info, has been added, which will display the existing data and the new data.

All InTouch Clocks: Allow Timesheet Change for Previous Pay Period

WFR-37080: Previously, timesheet change requests on all InTouch devices were only available for the current period,
which made it so that employees could not correct a missed punch from the previous pay period.

What’s changed: Users can now submit a timesheet Change Request from an InTouch device to correct a punch from the
previous pay period.

Bulk Time Input in Change Request
WFR-223615: You can now enter Bulk time as a number in minutes in the Change Request pop-up and this will properly
convert into HH:MM or HH.DD.

Display Predefined Default Cost Center in Change Request

WFR-223604: Previously, for any of the Add options in the timesheet Change Request pop-up, the cost center field
displayed as blank.

What’s changed: The employee’s default assigned cost center will now automatically display in the timesheet Change
Request pop-up for the Add change requests.

Time Off

Modify Time Off: My To-Do Items
WFR-220918: Previously, Modify Time Off was not available for non-consolidated time offs for multiple day requests, and
users could not modify a Time Off Request from a Time Off Request My To-Do Item.

What’s been added:Modify Time Off is now available for non-consolidated multiple day requests, which includemultiple
days and dynamic duration. In addition, a newModify button has been added to time off requests within the request’s
My To-Do Items.

Separate Time Offs and Cost Centers in Tree View
WFR-198967: Previously, when the Separate Cost Centers and Time Offs option was unchecked, time off categories did
not reflect in the Tree View. Going forward, time offs will display in the tree view as expected.
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Time Off Utilization Settings Not Applied
WFR-173219: Previously, Time Off Utilization settings configured in the Time Off Request profile were ignored when a
manager approved time off via the Pending Approval report. The time off utilization used the employee’s PTO balance
first before using the UTO balance.

This has been fixed, and going forward, when a manager approves time off through the Pending Approval report, the
time off utilization will be applied, and the UTO balance will be used.

Workflows

Line Break Formatting in Workflow Question
WFR-208852: Previously for users who used one Question step with multiple questions and/or lists, the user’s formatting
was ignored, and all questions/lists were formatted in one sentence. Going forward, questions configured in workflows
will display properly with the intended format.

Workflow Migration To-Dos
WFR-229964: Previously for some companies that migrated to the workflow approval process, administrators received
many To-Do Items for all items that had been submitted.

What’s been added: For users with Company Payroll Functionality enabled in their Security Profile from receivers of To-
Do Items, a new checkbox in the Approve/Reject workflow steps has been added, Exclude Payroll Admins. If this
checkbox is enabled, To-Do Items will not be generated for these users so that they do not receive an excessive number
of To-Do Items, but users will still be able to process submitted items via reports.

Webclock

Mobile Quick Punch and Change Cost Center
WFR-213642: As previously available in the Classic Mobile App, Quick Punch and Change Cost Center options are now
available for users to quickly clock in and out or change cost centers from the login screen in the NewMobile App.

To allow for quick punching in and out, navigate toMobile Quick Punch Preferences (Global Setup > Company Setup)
and enable the functionality with the Enabled checkbox. Within theQuick Punch Settings section, the following options
are available to enable for punching in/out:

• Allow Simple Punch

• Allow Punch IN

• Allow Punch Out

You can also enable options to allow users to change cost centers. Make sure Allow Mobile Login is enabled and enable
Show Change Cost Centers from theQuick Punch Settings section.

Updated Naming in Areas Used by Mobile Quick Punch
WFR-226118: Due to the Classic Mobile App being deprecated, in all areas where settings apply to Mobile Quick Punch,
Classic Mobile Preferences (under Company Settings > Global Setup > Company Setup) has been renamed toMobile
Quick Punch Preferences.
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Scheduler Enhancements
A summary list of the enhancements for the next system release is listed below. An in-depth explanation of these
descriptions is available in the regular detailed release notes. **For full details on any of the following enhancements,
including screen shots, please see the detailed Scheduler release notes for April 2021.**

   We are listening! Enhancements marked with the light bulb icon are a direct result of IDEAS submitted in
Community. Visit Community Ideas, upvote the best items, and keep the feedback coming!

Employee Profile

Daily Rules Limit List

WFR-197695, WFR-221386: Previously, users could create lists for daily schedules, but they were unable to assign a list
to a manager so that themanager was able to see only the Daily Rules in their list when creating basic schedules.

What’s been added: For TLM and TLM + Scheduler companies, a newwidget, Daily Rules, has been added in the
Employee Profile so that users can create and assign a limit list for managers. Basic Daily Rules will display in this widget.
Managers that are assigned a Daily Rules List will be limited to select only Daily Rules that are part of that list (in any TLM
page where a shift can be assigned).

Schedules

Added “Add New Shift” Button to Browse and Select Shifts Window

WFR-213374: As previously available in the Classic UI, in the Day, Week, and Month views in the NewUI, you now
have the option to add a new shift by directly clicking on the employee row. When you left-click in the row, a Browse and
Select Shift pop-up will display shifts that the employee would be qualified for. Once a shift is chosen, select Add New
Shift. TheManage Shiftwindowwill display where you can choose the date, adjust the shift time, etc.

Added Swap Selected Shift Option to Schedule Screens
WFR-213372: As previously available in the Classic UI, in the Day, Week, and Month views in the NewUI, you now have
the option to swap selected shifts when two shifts are selected. When you select two shifts, the pop-up will display a
Swap Shifts option.

Display Assigned Time Off Colors in Schedule Views
WFR-200768: Previously, all time offs in the schedule displayed as a green color.

What’s changed: You can now assign colors to time offs, which will make the time offs easily recognizable in any of the
schedule views andWeekly Schedule. Under Company Settings > Global Setup > Time Offs, choose a color for each
time off from the Time Off Color field.

Scheduler Fairness Additional Conditions Updated

WFR-202663: From New Scheduling Fairness Rule, if Changing Start/End Time is enabled and the Compliance
Payout is a time-based counter, a new section, Additional Conditions, will display. From this section, you can enter a
number of hours to add to the shift or remove from the shift. The formula is: Value * Total Canceled Hours.
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Scheduler Fairness Trigger for Posted Schedule
WFR-219766: Previously, Schedule Fairness triggered for changes made to posted schedules, but it did not trigger the
workflow for adding extra pay when posting a schedule that was in violation of the Scheduling Fairness rule.

What’s changed: If there are any Scheduling Fairness rules where an employee has to approve a change when a shift is
added to their schedule that includes extra pay, the system will look at the shift date on the schedule, and if pay needs to
be added for the shift depending on the Fairness Request Conditions, the employee will see the to-do item, as well as the
extra pay.

Schedule Week View PDF Print Version
WFR-181116: You can now download a PDF print version of the View By Week schedule. From this view, click the three-
dot ellipsis button at the top of the schedule, and select Download PDF. This print viewwill display the shift color,
schedule name and dates, shift skill, time, and scheduled cost center.
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HR Enhancements
A summary list of the enhancements for the next system release is listed below. An in-depth explanation of these
descriptions is available in the regular detailed release notes. **For full details on any of the following enhancements,
including screen shots, please see the detailed HR release notes for April 2021.**

   We are listening! Enhancements marked with the light bulb icon are a direct result of IDEAS submitted in
Community. Visit Community Ideas, upvote the best items, and keep the feedback coming!

New! UKG Ready Recruiting Workspace
Workspace Design in Job Requisitions
EPIC Tickets WFR-189220, WFR-189221, WFR-197745, WFR-197746, WFR-197747, WFR-197748, WFR-197749, WFR-197750

The workspace is a new optional design to provide flexibility for managers and recruiters to perform their day to day
activities efficiently by ensuring they can stay focused inside the workspace rather than navigating to multiple menu
items to perform various tasks in the process of identifying a suitable applicant.

• The new design will work on the desktop as well as a mobile device. The workspace is optional and is controlled by a
security setting. You will navigate to the Job Requisition report page under Team > Recruitment > Job
Requisitions. From there, you will select or create a job requisition and on that page you will see the option to
switch to the newworkspace once the security permission is set.

• You can enable users by security profile to have access to the newworkspace. Once enabled, they will see a banner
when opening or creating a Job Requisition in the Job Requisition menu under Team > Recruitment > Job
Requisitions. The setting is on the HR tab of security profiles in the Recruitment section. In the Job Requisitions
permission, check View Workspaces.

• After opening or creating a job requisition, the banner toggle will display. Users will click the Try the New
Workspace banner to open the newworkspace. To return to the old view, users will click the Back to Standard
View banner. In the Standard View, you will navigate through themenu structure to access each area.

Account Contacts
Employee PDF – Hiding Non-Visible Account Contacts in Downloaded PDF
WFR-217673: In the February 2021 HR Release Notes, we added an Account Contacts widget in Company Settings where
you can require, hide and display fields in the Account Contacts widget in employee profiles.

Note: For more details, please download the February 2021 HR Release Notes and refer to the Account Contacts
write up.

In this release we are hiding the contact type fields that are not marked to display in the Account Contacts widget in
Company Settings.

Example: After clicking the Download PDF button and selecting the Contacts widget in Print Settings, you can select
or de-select Contact Types to be included in the PDF. Any contact types that are not enabled in Company Settings
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will not display as an option in the Print Settings page. Conversely, if a contact type is checked under any contact
type or default, it will display as an option on the Print Settings page.

Company Settings
Restriction for Special Characters in Employee Profiles
WFR-223230: A newwidget, Restrict Special Characters, has been added to the Company Settings (in Account Policies)
where employers can turn the validation on and prohibit special characters for the following fields, listing which special
characters are prohibited.

Custom Forms
New Security Permission to Hide Custom Forms in Available Tab
WFR-198309: A new security setting has been added that can hide custom forms on the Available tab unless the custom
form has been assigned to the user. This solves the problem of sensitive custom forms being visible to all users who have
access to custom forms.

TheHide From Available Tab Unless Assigned setting has been added to theMy Custom Form Items widget under the
ESS tab of security profiles. For it to be active, the form item must be enabled with the View setting as a minimum.

When the hide setting is checked, only users assigned to that custom form will see it on the Available tab of custom
forms under Team > HR > Forms > Other Forms. These users will also see it on theOpen tab since they have been
assigned to the form and once submitted on the and Submitted tab. Once the form is submitted, it again is not visible on
the Available tab with this setting enabled.

• The hide option is available for View, Edit, and Delete only.

• Is a user has Add permission, the hide option is not activated since the Available tab is required in order to add a
form.

EasyBackgrounds
Password Fields in Desktop Experience vs Mobile Experience
WFR-202211: In the desktop experience (.hcm), the easyBackgrounds credentials password is displayed as *********
when the user opens the credentials page underMy Info > My Information > My Profile > easyBackgrounds
Credentials.

However in themobile experience (.home) underMy Info > My Information > easyBackgrounds Credentials, the
password field will always be blank (which is similar to other pages in .home) and the eye icon (Show) is displayed to view
the input password before saving.

Employee Profiles
Employee Sync Profile: Link Provided in Error Page
WFR-214501: When synching an employee profile and an error is received, a link to the page in question will be provided
in the error pop-up. Clicking the link will take you to that page so you can correct the error. For example, if the profile
cannot be synced because it is not compatible with the earning selected, the link would redirect you to that earnings
page.
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HR Actions
Effective Date Badge (InTouch) Fields Added to HR Actions
WFR-188897: Effective Date Badge fields (for Intouch) are now available in HR Actions.

Primary Phone Default Setting Added to Hire HR Actions
WFR-218329: In the February 2021 system release, we added an option in Company Settings where you can designate
the default primary phone to be either theWork, Home or Cell Phone upon hiring through themanual hire process or via
imports. We also added the ability for employees to designate a default phone number via a My Information HR Action.

Note: For more details, you can reference the February HR Release notes and search for the title of Company
Settings and under that title these three tickets explain the functionality: WFR-207775, WFR-16682, and WFR-207766.

In this release, we are extending the hire functionality via an HR Action. This will be done in theMy Employee Action
Request with sub type Hire. Within that HR Action, you can now add the Primary Phone action item. Whichever phone is
selected as default in Company Settings when hiring an employee or applicant through the HR Action, the system will use
that default unless the user overwrites it in the Primary Phone drop-down in the Hire HR Action.

Additionally, the Info icon verbiage in the Primary Phone field, located in the Other Defaults widget of Company Setup on
the Defaults tab, has been edited to reflect the release of this functionality.

TLM HR Actions with New Single Select Lookup
WFR-208848, WFR-208846, WFR-208844, WFR-208843: A new single select lookup is available in the Pay Calculations field
within HR Actions. In addition, the new single select lookup is available in the Browse and Select TS Auto Population
Profile, Time Off Planning Profile, and Holiday Table pop-ups within HR Actions.

Imports
Employees Import: Emergency Contact Required/Not Required Based on Account Contacts
Widget
WFR-217646: In the February 2021 release, we introduced a newAccount Contacts widget in Company Setup. In this
widget you can customize how employee account contacts are to be added and whether they should be required or not
required. For more details, please download the February 2021 HR Release Notes and search for the Account Contacts
title (page 6 of document). In this release, we are upgrading the Employees import template to accommodate the
Emergency Contacts for this new functionality.

The template contains a section titled Emergency Contact Fields of which, Emergency Contact Relationship has
historically been marked as required. However, with the introduction of this newwidget, the required field will now be
based on the configurations in the newwidget.

Lookup List Updates
Benefit Plans Details Page Updated with Employee Lookup
WFR-218667: The Benefit Plans Details page in themobile experience has been updated with an Employee lookup.
Formerly, this page contained an employee selection drop-down. The new lookup will open the standard application
Browse and Select Employee report pop-up, which gives you greater control over the employee selection list. This page is
accessed under Team > Benefits > Benefit Plan Details.
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Company Asset Lookup Replaced with Report Based Lookup
WFR-211650: When assigning assets to employees under Team > HR > HR Maintenance > Assets Assignments, the
Company Asset field lookup has been replaced with a report page style lookup to give greater control over the asset list.
Formerly, this field contained a drop-down style lookup. This lookup will also be available if assigning assets via an HR
Action.

Vehicles Lookup Replaced with Report Based Lookup
WFR-211650: When assigning vehicles to employees from the Vehicles widget of their employee profile accounts, the
Company Vehicle field lookup has been replaced with a report page style lookup to give greater control over the vehicle
list. Formerly, this field contained a drop-down style lookup.

HR Action Items Lookups Replaced
WFR-208771: The lookup for HR Action items Default Workers Comp Code, Labor Distribution Profile and Pay Period
Profile have been updated to a single select style. Users/managers can open their HR Action and from the lookup for
these items, select a single item for that action item.

WFR-226019: The Vendor lookup when editing a deduction in the Deductions widget of an HR Action, has been updated
to a single lookup.

Peer Feedback
New Notification When Provider Gives Feedback

WFR-218140: A new Peer Feedback Provider Added Comment notification has been added to the notifications
maintenance area, located under Company Settings > Global Setup > Notifications, in the Peer Feedback category. This
notification will trigger each time a provider gives feedback and can be sent as a message to themanager of the employee
and/or themanager of the provider. The notification will also work with the SMS Twilio Marketplace product (if enabled)
and an SMS message can be added to the notification.

Recruitment - General
Applicant Created Dates & Applicant Hired Dates in Multi EIN Companies
WFR-222642: Previously, the system was updating the created dates of the applicant record when an applicant was hired
in a multi EIN environment. The applicant created date was not retained, and users could not run a report to show the
time an applicant was in the system before being hired. To address this issue, the following changes have been applied.

• Created date on the Applicant report reflects the original date the applicant record was created and will not update
to the date the applicant was hired into the system.

• Created date on the Employee report reflects the date when the employee record was created, i.e. the date the
applicant was hired in the system.

• Added the "Applicant Created" column in the Time to Hire report.

• Renamed "Created" column to "Employee Created" on the Time to Hire report.

• This is not retroactive and is only valid going forward.
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Icon Changes in Recruitment Pages
WFR-216231: Some updates have been made to the icons in several places in Recruitment. These changes primarily affect
the View or Edit functions. The updates are as follows:

• Job Requisition Report Page: View Job Requisition - Pencil icon

• Job Application Report Page: View Job Application - Pencil icon

• Job Application Report Page: View Job Requisition - Briefcase on page icon

• Job Application Report Page: ViewQuestionnaire - Question mark on paper icon

• Questionnaire Answers Report Page: ViewApplicant - Employee Profile icon

• Questionnaire Answers Report Page: View Job Application - Person on page icon

Job Requisitions: Recruitment Filters Added for Job Applications
WFR-201558, WFR-201559, WFR-201550: Multiple filters have been added to the Global filters when navigating to the Job
Applications page within the Job Requisition report page.

Note: These options are available in both Standard View and the NewWorkspace. The navigation path listed below
is how to access these filters in Standard View. The options in the NewWorkspace will be available from the
Applications tab in the Quick Filters panel.

• Hiring Stages - These filters provide options of selecting and filtering job applications with or without hiring stages.

• Applicant Type – These filters provide options of selecting and filtering job applications by applicant type External,
Internal, and Returning Employee.

• Job Application Status – These filters provide options of selecting and filtering job application by All Applications or
NewApplications.

Navigate to:

1. Team > Recruitment > Job Requisitions

2. Click the View Job Requisition icon to navigate to the Job Requisition details page.

3. Access the applications via the Applications jump link.

4. From the Applications widget, click View Report option from the ellipsis.

5. Click the funnel-shaped Filters icon. The filters will display on theGlobal tab.

Job Requisitions: New Dashboard Widget - My Open Job Requisitions
WFR-217227: A newMy Open Job Requisitions widget is available to be added to your dashboards. The widget will show
all open job requisitions. When selecting one of the requisitions from the widget, the requisition will open for viewing
and/or editing. On this page, if the new Job Requisition Workspace has been enabled, users can select the banner to
open the newworkspace and work with that open requisition and related applications there (see details about the new
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workspace in this document.) Selecting the back button will return the user to their dashboard. Selecting the hyperlinked
title of the widget will open the Job Requisition report page and will show only your open requisitions.

• Users must have security enabled for the Job Requisitions permission, with View as theminimum setting. This is set
in the Recruitment section of the HR tab in security profiles.

• Users must also have security enabled for dashboards. In the Dashboard Widgets section, located under the
Dashboards tab of security profiles, ensure the users have permission to this widget. Select either All or Custom. If
selecting Custom, select the Permissions button and select the dashboard widgets the users can see and use.

Workflows
Collect Note Options Added to Approve/Reject Step of Custom Form Workflows
WFR-212197: Historically, the Collect Note step in a Custom Form workflow is used so managers can add a note during
the workflow process. This step in a workflow results in another To Do Item for themanager. In this release, we are
adding configuration options to combine the approve or reject process with the collect note process.

In the Accept/Reject step of Custom Form workflows, a configuration option to collect a note has been added, along with
an option to make it required. With these options, when a manager does the approval or rejection, they can add the
note in that same step without receiving a separate Collect Note To Do Item.

Summary Release Notes © 2021, UKG Incorporated 25



Payroll Enhancements
A summary list of the enhancements for the next system release is listed below. An in-depth explanation of these
descriptions is available in the regular detailed release notes. **For full details on any of the following enhancements,
including screen shots, please see the detailed Payroll release notes for April 2021.**

   We are listening! Enhancements marked with the light bulb icon are a direct result of IDEAS submitted in
Community. Visit Community Ideas, upvote the best items, and keep the feedback coming!

Important! Quick Payroll Under Construction
WFR-219834: In the February 2021 release notes, we notified you that we aremaking some required UI changes to Quick
Payroll, and that the functionality would not be available when the April 2021 release is applied to your server. As of this
release (April 2021), Quick Payroll will be unavailable, and its unavailability will likely extend into future releases. When it is
ready, wewill notify you in the release notes.

1099-NEC data can now be reported in Electronic Forms
WFR-223244: On the EF W2/1099 Files page, when users click the Create EF W2/1099 Files button to create a form 1099
for the following states, the system creates one Electronic File with the B record for 1099-MISC and 1099-NEC forms:

• Oregon

• Vermont

Pennsylvania is slightly different from Oregon and Vermont. When users click the Create EF W2/1099 Files button to
create a form 1099 for Pennsylvania, the system creates separate Electronic Files: one containing 1099-MISC forms, and
one containing 1099-NEC forms.

For all three states, users must enable the state-specific EF formats at Company Settings > Global Setup > Company
Setup on the Payroll Tab in the Printed W2/1099Options widget and the 1099 section.

CARES Act retention credits are extended into 2021
WFR-216585: The system is updated to calculate the CARES Act retention credit into 2021. The calculation is based on the
earnings and deductions in a pay statement.

FFCRA earnings types are extended into 2021
WFR-216570: The system is updated to extend into 2021 the Earning Limit for the three FFCRA earnings types, which are
as follows:

• FFCRA Family 10 day with 2000 limit

• FFCRA Sick 10 day with 5110 limit

• FFCRA Family Leave 10week with 10000 limit

MasterTax Specification Updates are Applied
WFR-230144, WFR-231612: MasterTax RTS and PTS files are now updated to match theMasterTax specifications for the
first quarter of 2021.
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State Forms are Updated for 2021
WFR-204763: The following updated state-specific forms for 2021 are now available in the system:

• Connecticut: W-4

• Maryland: MW507

• Minnesota: W-4

• New Jersey: W-4

• North Carolina: NC-4, NC-4EZ
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Cross Product Enhancements
A summary list of the enhancements for the next system release is listed below. An in-depth explanation of these
descriptions is available in the regular detailed release notes. **For full details on any of the following enhancements,
including screen shots, please see the detailed Cross Product release notes for April 2021.**

   We are listening! Enhancements marked with the light bulb icon are a direct result of IDEAS submitted in
Community. Visit Community Ideas, upvote the best items, and keep the feedback coming!

Only for United States: The Payroll note below is applicable for U.S. users only.

IMPORTANT! Quick Payroll Under Construction
WFR-219834: In the February 2021 release notes, we notified you that we are in the process ofmaking some needed and
required UI changes to Quick Payroll, and the functionality would not be available once the April 2021 release is applied to
your server. As of this release (April 2021), this feature will be unavailable and this will likely extend into future releases.
When it is ready, wewill notify you in the release notes.

Access Control

Timesync as an Immediate Command
WFR-205429: Users can now trigger the Timesync as a manual command, allowing them to correct any issues with either
DST or time desync.

Only for UKG Ready™ Customers: The Advanced People Analytics - Full items below are currently avail-
able for UKG Ready™ Customers only.

Advanced People Analytics

Internal Benchmarks by Cost Center Report: Show Employees Using Prompt
WFR-216564: Users can now choose the data type to be used for Employee information on the Insight Explorer so that
the displayed data is informative to them. On the Internal Benchmarks by Cost Center report, there is a new
prompt/drop-down for Show Employees using. This new prompt is available for Questions 0, 1, 4, and 5. A new column,
Full Name, is available for inclusion in this and all Analytics reports.

Question 0 in Guided Analysis for the Internal Benchmarks by Cost Center Report
WFR-206062: The Question 0 question,What is the state of my organization for benchmark metrics?, is available on
the Guided Analysis panel of the Internal Benchmarks by Cost Center report. The AIMEE view is generated after clicking
on the ASSIST ME button.
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Employee Using Prompt for Guided Analysis Questions in Internal Benchmarks By Managers
WFR-216582: Users with access to the Internal Benchmarks By Managers report can now choose the data type to be used
for Employee information on the Insights Explorer so that the displayed data is informative for them. There is a new
drop-down, Show Employees using..., with options for Employee Id (default), User Name, and Full Name.

Exclude Employees from the Internal Benchmarks Model
WFR-183148: Admins can now exclude Employees/Groups from an Internal Benchmarks Model run as they may not be
relevant for tracking. Within the AIMEE Definitions screen, when an Admin clicks on the people icon, an Employee
Lookup section labeled Employees To Exclude From Model can be used to define which employees to exclude.

Exclude Group of Employees from Reports

WFR-219532: Users can utilize the Employees To Exclude From Model option in the AIMEE Definitions settings to
exclude groups of employees from themodel run. The excluded employees also do not display on the Internal
Benchmarks reports (By Managers or By Cost Centers).

Filter Option on Saved Charts for Dates
WFR-218926: Users can now see the date filter on the Saved Charts in the Insights Explorer in the Analytics reports so that
they knowwhat date filter has been applied.

Manage Existing Charts Panel in Insights Explorer
WFR-212069: Users can now see the updated Manage Existing Charts panel (previously Add Existing Chart), which
resembles the current Charts panel and contains a re-arrange function (Up and Down arrows). The new panel view is in
table modewith a checkbox to select each chart, the Chart Name, and the Display toggles. Upon clicking on the Chart
Name, the Edit Chart Settings panel is opened.

WFR-170850: Re-arrange arrays (Up and Down arrows) are available on theManage Existing Charts panel. When a user
selects the checkbox for a chart, the Up and Down arrows become active. A new chart order is saved and applied after
saving theManage Existing Charts panel. When a user selects the first or the last chart in the list, the Up or Down arrow is
disabled.

Print the Insights Explorer Screen
WFR-153686: Users can now print the Insights Explorer screen so they have the same behavior as standard charts. When
the user is on the Insights Explorer screen, the system displays a Print option in the top ellipses which allows the user to
print the Insights Explorer screen. The system prints the charts or grids depending upon what is on the screen.

Insights Explorer Manage Existing Charts Panel Bottom Section Anchored
WFR-214967: The bottom section of theManage Existing Charts panel, with theDelete and Re-Arrange action icons, is
now anchored above the Save/Cancel buttons so that users can see the buttons without scrolling down.

Reset Function for the Insights Explorer Page
WFR-162194: The Reset option, which is under the top ellipses of the Insights Explorer page, is now disabled until changes
are performed in the Pivot table.
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Multi-Chart Print on the Insights Explorer Page
WFR-213909: Amulti-chart Print function is now available so that users can print all of the saved charts on an Insights
Explorer page. There is a new Print icon in the header of the Analytics reports. Charts with any errors are not printed.

Stack Charts Option for Pivot Tables
WFR-191753: Users now have the option to stack bar and column charts created through Pivot functionality to better
arrange their data. A new checkbox, Show as a stacked chart, is displayed on the Edit Charts Settings panel in the
Insights Explorer within the Analytics reports. It is only available for column and bar charts provided that both Metrics
and Dimensions are defined. In other cases, the Show as a stacked chart checkbox is not shown.

Hidden Actions for Pivot Tables in Chart View
WFR-162196: Three options (Format Cells, Conditional Formatting, and Layout Options) under the ellipses are now
hidden for Pivot Tables when data is viewed as a chart.

Disabled Navigation from Dashboard to Explorer Page on Mobile
WFR-179250: Users cannot navigate from the Dashboard (Pivot Chart) to the Explorer page using theMobile Application.

Custom Format Cells in Insights Explorer
WFR-174295: Users now see a Custom Format Cells dialog in Insights Explorer on Analytics Reports. There is a custom
Format Cells dialog in the Pivot Table when opening the Format Cells dialogue.

No warning message (You have some unsaved changes...) displays if the user makes some format changes for one value
without applying them, and then switches to another value. All changes for the first value are reset.

When a user changes any option in any drop-down and then selects a new column in the Choose Value drop-down, the
system puts all of the changed options back according to the selected column.

Validation on 24-Hour Window Between Enabling of Analytics and Import
WFR-226084: If a user tries to import fake data for a company (fromMaintenance > Imports > Advanced People
Analytics > Analytics Demo Data in an Admin company) for which the Advanced People Analytics: Full functionality has
been enabled for less than 24 hours, users need to bemade aware that the import is not possible so the import can be
attempted at a later time. If validation fails, an error message displays explaining that the Import has failed because
analytics was enabled for company less than 24 hours ago. Please try import again tomorrow.

View Report Data and Back Buttons on the Reports
WFR-176748: When a user navigates from a Dashboard (Pivot Chart) to the Insights Explorer page, a View Report Data
option/button is available for selection and navigates the user to the appropriate report. This option is available with the
same logic on all Insights Explorer pages.

After completing a Save As on an Insights Explorer page, the newly created report view is opened after clicking the View
Report Data button. The View Report Data button is displayed for Guided Analysis pages and on the Insights Explorer
after navigating from the Dashboard.
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Only for United States: The Affordable Care Act features below are applicable for U.S. users only.

Affordable Care Act (ACA)

2020 Changes to DC ACA Reporting
WFR-221644: The system nowhas the updated version of the file specifications for the healthcare reporting files required
by the District of Columbia, which allows users to submit their file electronically with no errors.

California ACA Reporting
WFR-207120: California has introduced their own type of healthcare reporting that is due for the first time for the tax year
2020. The file format is similar to the Federal XML file, and like the Federal filing, test filings must be done first. All three
options to Generate CA ACA, Generate CA Test File1 and Generate CA Test File2 are showing properly under the ellipses
of the last step of the Generate AIR Files process.

WFR-207284: The system provides the first test file required for CA healthcare reporting to be sent directly and perform
the first required test. The filing requires two test files (whereas the Federal filing only requires one test), so these test files
have been introduced in the system.

The first test file is similar to the IRS AIR TCC Communication Test file, only it is updated with all of the CA specific field
labels. As with the IRS' test file, this is filled with dummy data and is validated character by character. When a user selects
theGenerate CA Test File 1 option under the final step of the Generate AIR Files process found within the ACA Year End
Processing Checklist, s/he is presented with a pop-up similar to a combination of the pop-up presented when a user
selects theGenerate DC ACA option and when they click on the TCC and Software ID button. California issues employers
their own separate TCC (Transmitter Control Code) and there are actually separate TCC's issued to the employer for
testing and production. The Transmitter Control Code (TCC) field allows a maximum of five characters and only allows
letters and numbers (no special characters).

WFR-230462: As mentioned in the validations for the test files, in the California ACA file, the Transmitter Control Code
(TCC) accepts only 5 digits with the pattern [0-9A-Fa-f ].

WFR-207286: The second test file is also similar to the IRS AIR TCC Communication Test file, only it is updated with all CA
specific field labels and it is for corrected forms. As with the IRS' test file, this is filled with dummy data and is validated
character by character. When a user selects theGenerate CA Test File 2 option under the final step of the Generate AIR
Files process found within the ACA Year End Processing Checklist, a pop-up displays. A blue information bar reads Enter
the California Testing TCC, The Receipt ID from your first CA ACA Test File, and press "OK".

When the user selects theGenerate CA Test File 2 option under the final step of the Generate AIR Files process within
the ACA Year End Processing Checklist, if the user has entered a valid Transmitter Control Code (TCC) and a valid CA
Receipt ID, the file is generated successfully.

WFR-207270: The California filing itself consists of a Manifest and Form Data File, the same as the Federal AIR filing. The
system guides users when creating a live production file so they can be sure that their file is being created accurately,
allowing them to file without incident.

When a user selects theGenerate CA ACA option under the final step of the Generate AIR Files process found within the
ACA Year End Processing Checklist, s/he is presented with a pop-up similar to a combination of the pop-up presented
when a user selects theGenerate DC ACA option and when the user clicks on the TCC and Software ID button. California
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issues employers their own separate TCC (Transmitter Control Code), and there are separate TCC's issued to the
employer for testing and production.

California Form Data File
WFR-207118: California has introduced their own type of healthcare reporting that is first due for the tax year 2020. The
file format is similar to the Federal XML file, but there are some differences between the AIR Form Data File and the
California Form Data File.

California Manifest File
WFR-207121: California has introduced their own type of healthcare reporting that is first due for the tax year 2020. The
file format is similar to the Federal XML file, but there are some differences between the AIR Manifest File and the
California Manifest File. The CA version requires a lot less information.

Announcements

Linkable Entries in Visible To Columns
WFR-211558: The data that populates the Visible To Group and Visible To Security Profile columns in the
Announcements (Maintenance) report page will now by hyperlinked. This can also be accessed via the Announcements
button in Dashboard Layout Profiles.

• In the Visible To Group column, clicking the entries will take you to the Edit Dashboard Layout Profile
maintenance page.

• In the Visible To Security Profiles column, clicking the entries will take you to the Edit Security Profile
maintenance page.

Note: This is not yet supported in theMobile App.

Charts

Charts Page: Display Actions on the Section not in Ellipsis
WFR-215583: When users access a report page with the Charts View toggle enabled, they now have options just in the
section and no longer in the Ellipsis menu so they can use them in one click. There is no ellipsis, and there are separate
Print (icon) andManage Existing Charts buttons in the section.

Company Settings

Restrict Special Characters in Certain Fields
WFR-223230: A newwidget, Restrict Special Characters, has been added to the Company Settings (Company Settings >
Global Setup > Company Setup, in Account Policies). Employers can enable this validation via a checkbox to prohibit
special characters for the following fields, listing which special characters are prohibited:
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• Name: This includes all Name fields such as First Name, Middle Name, Last Name, Nickname, and Suffix.

• Phone: This includes all phone fields such as Cell Phone, Home Phone, and Work Phone.

• Username

An informational message explains that the special characters should be entered without any spacing or delimiter such as
a comma.

Only Special Characters are allowed in all fields under the Restrict Special Characters settings section. If a letter or
number is entered, an error message displays explaining that it must be a special character. Themaximum length of each
field in the Restrict Special Characters section is 35 characters.

Tip: If a special character is included in theGenerate Username Format, it should not be entered as a prohibited
special character for the Username in the Restrict Special Characters. A warning message will display explaining that
there are Conflicting values under Generate Username Format & Username section under RESTRICT SPECIAL
CHARACTERS.

WFR-210494: If Restrict Special Characters is enabled in Account Policies and prohibited special character(s) is/are
entered on the Employee Record (ESS and MSS), an error message displays indicating the special characters are invalid
and prohibited.

WFR-215678: Users will receive an error message indicating the special characters are prohibited if they enter special
characters via the Employee Import that are listed in the Restrict Special Characters section for the field(s).

Note: In an Employee Import, an Error displays if there is a prohibited special character in a Required field such as
Username, First Name, or Last Name, and the system will not allow the record to be imported at all. AWarning will
display for prohibited special characters in a field that is not required such as Work Phone, Home Phone, Cell Phone,
Middle Name, Nickname, and Suffix. The system allows the record to be imported, however fields with prohibited
special characters are skipped. If there are existing validations for any of the fields, the existing validations display
first and then the new special character validations display next.

WFR-215679: When users enter special characters via HR Actions, and those special characters are listed in the Restrict
Special Characters section for the field(s), they will receive an error message when clicking Save or Submit indicating the
special characters are prohibited.

Cost Centers

Cost Center Lookup Redesign
WFR-190600, WFR-193188, WFR-209711, WFR-209710, WFR-209949, WFR-209945: All cost center lookups have been
updated. When you click into any single select cost center look up fields, the Browse and Select Cost Centers pop-up will
display with the standard report filtering and the full path of the cost centers. Under the List View tab, if more filtering is
needed such as for external IDs, payroll codes, etc., you can bring in additional cost center columns, and you can save
your view.
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Tip: If you save a view in the default cost center widget, that viewwill display across the application with the
exception of theManaged Scheduled Cost Centers, Scheduled Cost Centers, andManaged Cost Centers widgets,
which give you the option to save cost center views specific to those widgets.

The cost centers are single select, and when you make a selection, the pop-up will close.

Note: Multi-selecting cost centers is available for theManaged Scheduled Cost Centers, Scheduled Cost Centers,
andManaged Cost Centers widgets.

If you prefer the Tree View, you can select a cost center from the Tree View tab. Select the arrow next to the cost center
and any child cost centers associated with the parent will display.

Tip: The Tree View tab will not be available if there aremore than 750 cost centers in any node.

Dashboards

Dashboard Updates: General
The following updates have been made to dashboards.

Ticket
Number

Update/Issue

WFR-
220532

Under Company Settings > Profiles/Policies (orMaintenance > Companies > Client Resources >
Global from an Admin company), menu items for ContentWidget Library and Dashboard Layout
Profiles are now nested under the Dashboard Layout mainmenu item in the hamburger menu.

On Entry Show Specified Tab Upon Login on the Dashboard
WFR-197425: Admins need to define and schedule which tab should be viewed when users log in and access the
Dashboard. This allows administrators to control the focal point of the end user Dashboard experience at difference
stages. TheOn Entry Show option is available to Admins and located within the gear icon on the Dashboard
Configuration page.

By default, the Last Visited tab is selected. If settings are changed in an active Schedule, changes are applied after the
Schedule is Reset in either the Dashboard Layout Profile or Security Profile. Settings are applied immediately if a new
Schedule Date becomes active or a new Layout Profile is assigned, and when a user logs in to the application or clicks the
Home button.

Note: TheOn Entry Show is not available on the Landing page for end users under the gear icon.
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Domain Dashboards Renamed
WFR-210550: When searching for "Dashboard" in themain menu, all Domain Dashboards appeared in the search with
the same name, which looked confusing. Now the Domain Dashboards have been renamed and appear in themenu as
follows:

• HR Dashboard

• Talent Dashboard

• Succession Planning Dashboard

• Learning Dashboard

• Compensation Dashboard

• My Team Dashboard

• Recruitment Dashboard

• Payroll Dashboard

• Time Dashboard

• Accruals Dashboard

• Leave Dashboard

• Schedule Dashboard

• Benefits Dashboard

• Analytics Dashboard

Company Default Column in Manage Views Popup
WFR-210383: Users who can manage views on Custom tabs of the Dashboard (User Can Modify checkbox is enabled for
current schedule) can now see which Dashboard View is selected as the default for themselves and for their company so
they don't have to check it manually in every view. By clickingManage Views in the ellipsis menu of the Dashboard tab,
theManage Views pop-up opens. TheDefault column has been renamedMy Default, and a Company Default column
has been added next to theMy Default column. The Company Default column shows which View is set as the default for
all users in the company. The letter "Y" is present in the row for the viewwhich is selected as the default for all.

Security Item Logic for Company Types Dashboard Views
WFR-213514: Users can share saved Dashboard Views with other users without dependency on the reporting framework.
In the security profile on the Dashboards tab, any dependency of the Share With All radio button in the Save View
As/Save View pop-up from the Report Settings checkbox on the Global tab has been removed. TheManage Company
Type Views has been added to the Sharing section of the Dashboards tab.
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Security Item Logic for Dashboards Shared Views
WFR-211354: Users can share saved Dashboard Views with other users without dependency on the reporting framework.
In the security profile on the Dashboards tab, any dependency of the Share option in Save View As/Save View pop-up
from the Report Sharing User Selection checkbox on the Reports tab.

TheDashboard Sharing User Selection security item in the client-level security profile (Dashboards security items) has
been renamed Dashboard Sharing. TheDashboard Sharing User Selection item has been added below theDashboard
Sharing option in the Sharing section. By enabling this checkbox, users can share saved views with others.

Migration of Security Items for Dashboard Shared Views
WFR-214444: Users can preserve all previously existing functionality connected with sharing Dashboard views options so
they won't be affected after reducing dependencies from report settings security items. Security Items that were created
to control sharing Dashboard views options are checked or unchecked in security profiles depending on the state of the
related security items that initially controlled the functionality.

New! Company Hub Dashboard Layout Configuration
**A new Company Hub Tips/Tricks User Guide with additional information on this new functionality is coming
soon and should be available within the next 1-2 weeks.**

A newDashboard Layout Configuration setting, Company Hub, gives your company a way to communicate and provide
vital resources to your people. This option has been designed to deliver branded content to build unique company
experiences. A single adaptable display pulls all your key organization-level information into one place for your
employees. News feeds, embedded videos, and helpful links can communicate company standards, culture, and
announcements.

Quick-start templates and formats make it easy to create views that match your organization's needs. This new
experience provides specific widgets alongside customized Content widgets, allowing for up to 20widgets per tab. With
the Content widgets, this provides an Intranet within the Dashboard that is a read-only experience for end users.

WFR-188771, WFR-206282, WFR-206279, WFR-209638, WFR-211335: The new setting/option, Show Company Hub, is
now available in theDashboards Visibility section of the Dashboard Layout Profiles. When this option is enabled and a
user selects Edit for one of the Schedules, grid lines outline different sections to be included in the layout when Edit
Mode is on. The following sections can be added to the layout:

• Top Section

• Left Section

• Middle Section

• Right Section

By enabling Edit Mode, the layout includes the ability to add/configure the new sections on each individual tab so they
will appear on the Dashboard as desired.

Company Hub Tabs on the Dashboard Configuration Page
WFR-209692: Admins can add Company Hub tabs to the Dashboard Layout Configuration so they can create specific
content for end users. By clicking the gear icon in the header of a Dashboard, the Edit Tabs option appears in the drop-

Summary Release Notes © 2021, UKG Incorporated 36



down and when selected, opens the Edit Dashboard Tabs dialog page with options for:

• Company Hub Tabs: The functionality below is available for the Company Hub Tabs:

• + Add: To add a new Company Hub tab

• Select Row(s): To select existing tabs

• Tab Name: Tab Names can be edited here

• Delete: Once at least one existing tab is selected, the trash can icon is available to delete a tab or tabs.

• Display Toggle: Enabling this tab displays the new Company Hub Tab on the Dashboard Layout.

• Up and Down Arrows: Use these to re-arrange the tabs

• Custom Tabs: The same options are available for the Custom Tabs.

New Widget Notification With New Grid
WFR-212356: The newwidget notification provides users with dialogue when newwidgets are available, and it allows the
user to add widgets directly to tabs. When multiple sections are present in the new grid, if a user chooses to add a widget
via the newwidget notification dialogue, the content is placed in themiddle section of the new grid Dashboard Layout.

Move To Functionality for New Grid
WFR-206387: Users can move existing tiles to a different section so they can organize all information in a specific order.
When a tile has been added to a section within a Dashboard Layout Profile (Company Settings > Profiles/Policies >
Dashboard Layout > Dashboard Layout Profiles, select View/Edit Dashboard Layout Profile, Edit the appropriate
Schedule), a tile with an ellipsis menu is presented on the Dashboard. Clicking the ellipsis menu exposes a drop-down list
with aMove To option.

Copy Tabs From Classic With New Grid
WFR-212355: Within Edit Tabs, users can copy tabs from the Classic UI. With the new grid/Company Hub, the following
options are available to users when multiple sections are present in the new grid:

• By clicking Edit Tabs in the header of Dashboard, an Edit Dashboard Tabs pop-up appears on the page. At the top
of the pop-up on the Custom Tabs screen, a message explains that Content is available from your Classic UI.
Copy tabs from Classic UI.

• By clicking the Copy tabs from Classic UI link in themessage, a Copy Tabs from Classic UI pop-up with a list of
available tabs and items appears. When a user chooses to copy tabs from Classic, all content is placed in themiddle
section of the new grid Dashboard Layout.

Add Items to Sections of Company Hub Tabs
WFR-211327: Users can add different items to every section in the Company Hub tabs (Dashboard Layout Profile under
Company Settings > Profiles/Policies > Dashboard Layout> Dashboard Layout Profiles, select View/Edit Dashboard
Layout Profile, Edit the appropriate Schedule) so that they can organize information in a proper way.
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By clicking Add in every section, a drop-down list with the following options is available:

• Widgets

• Content Widgets

• Create Content Widget

Users cannot add or create Reports, Charts, or Pivot Charts. Only non-ESS and non-MSS widgets are available for adding
to a tab, such as:

• Announcements

• Documents

• Events

• Links

• Content Widget(via the separate option in the Add drop-down list)

• Start

• Turtles

• Websites

Middle Section Configuration in New Grid
WFR-207970: Users can placemore tiles in themiddle section of the new grid so themain Widgets/Charts are in one
space. When the Dashboard grid (Dashboard Layout Profile under Company Settings > Profiles/Policies > Dashboard
Layout > Dashboard Layout Profiles, select View/Edit Dashboard Layout Profile, Edit the appropriate Schedule) is
presented and the Edit mode is enabled, theMiddle section is displayed by default

WFR-218776: Users can view up to three columns in themiddle section so that previous versions of the Dashboard
Layout are not affected after changes are applied with the new grid. Every column is added dynamically depending on the
section width, and the columns appear adaptively depending on the width of theMiddle section. The Resize tiles
functionality is supported for 1 to 3 columns.

WFR-217622: Users can change the view of the tiles in middle section so they can restructure the tiles. When the
Dashboard grid with a middle section is presented on the page with the Edit Mode enabled, options for List View and
Matrix View are available at the top of themiddle section.

• By selecting the List View option, all tiles are placed one under another as a list.

• By selecting theMatrix View option, all tiles are placed next to each other as a matrix.

New Grid Type for End Users
WFR-205226: Users can now conduct changes on their Dashboards so that they can organize it in a more convenient way.
When navigating via the Home button in themain hamburger menu, users see the Dashboard, where these changes
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have been made:

• The Edit Tabs text next to the Gear icon in the header of the Dashboard and on the Configuration page has been
removed.

• An Edit Mode toggle is available to control the Edit Mode on the page.

• The Ellipsis Menu and Full screen buttons have been removed completely from both the Admin and end-user
Dashboard.

• By clicking on the Gear icon, a drop-down list with the following options appears on the Configuration page:

• Edit Tabs

• On Entry Show

• By clicking the Gear icon, a drop-down list with the following options appears for Custom Dashboards on the
Landing page:

• Edit Tabs

• Enable Edit Mode/Disable Edit Mode

• Reset Configuration

• Refresh

• Print

• By clicking the Gear icon, a drop-down list with the following options appears for Domain Dashboards on the
Landing page (and for Domain Dashboards from themain menu):

• Edit Tabs

• Enable Edit Mode/Disable Edit Mode

• Refresh

• Print

• Save View...

• Save View As...

• Manage Views...

Full Screen Mode for Report/Chart Tiles in Sections of the Company Hub/New Grid
WFR-224173: If the Company Hub/new grid is being used, Report and Chart tiles in full screen mode are handled as
follows:
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• A Report/Chart tile with the Full Screen option is presented in every section of a Dashboard tab.

• By clicking the Full Screen button for the tile, the Report/Chart is expanded on the page.

• The Report/Chart tile covers other sections of the Dashboard.

• To exit the Full Screen mode, users can press the ESC button or click on the Full Screen control for the tile.

Gear Icon Options on Dashboard in Company Hub
WFR-220426: The gear icon dynamically shows options based on the tab the user is on (i.e., if a user is on a Domain tab,
s/he will see Save View, Save ViewAs, Manage Views). Under the gear icon, the following apply:

• When a user is on a Company Hub tab, s/he does not see the options to Print or Reset Configuration as they are
not supported options.

• When user is on a Custom tab and does not have permission to modify (User Can Modify is disabled), the Reset
Configuration option is not available.

Edit Mode Toggle Disabled Without Permission to Modify Dashboard
WFR-220191: When a user does not have permission to modify their dashboard, s/he also does not have access to the
Edit Mode toggle. The following items are not available to the user:

• The Edit Mode toggle

• The Enable Edit Mode item in the Gear menu

• The Ellipsis menu for Widgets

All edit options are absent on the Company Hub tabs. Edit options are available for users on the Domain tabs in
accordance with the Saved View permissions.

Company Hub Tabs Available Independently from Other Tabs
WFR-221132: If Show Custom Dashboards, Show Domain Dashboards and Show My Dashboard toggles are off, but the
Company Hub tabs are on, users see an informational message about the Dashboard unable to display contents.

Admin Remains on Same Dashboard Tab After Reset Layout
WFR-216436: When a Company Admin makes changes to a specific tab on the Dashboard Layout Profile and clicks Reset
Changes, s/he remains on the same tab after the layout is reset. If an Admin clicks Reset Layout without saving a recently
created tab, s/he is redirected to the first Custom tab. If no Custom tabs exist, the user is redirected to the first Company
Hub tab.

Events Widget Added to List of Available Widgets on the Company Hub Tab
WFR-226788: Where the Add Widgets pop-up is presented on the page, the Events widget is now included in the list of
AvailableWidgets, and can be selected to add to the Company Hub tab.
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Dashboard Widgets

New Widgets Available

Note: The additional Dashboard widgets may not be available immediately following the release. These newwidgets
will be steadily rolled out to companies after the initial release date for each POD. The widgets will bemade available
via a gradual rollout across the 3-4 weeks following the April 2021 release.

The following widgets are now available for use in the NewUI Dashboard: 

• Leave of Absence Cases, including the ability to create new cases.

• Events

• Employees

• ACA Compliance Overview

• Time Summary

• Content

Note: The # Items to Show option has been removed from the Classic Dashboard widget, which allows the Classic
and NewUI to support the ability to use date range-based filtering.

Content Widget: New!
WFR-183527, WFR-187061, WFR-192224: A new Content Widget is now available so you can add customizable content
pertaining to your specific company needs. Multiple widgets can be created and added to the tabs of your dashboards.

This content can be created and added by clicking the Content Widget Library button under Company Settings >
Profiles/Policies > Dashboard Layout > Content Widget Library. Click Add New to create a new Content widget.

Administrators can use the +Add drop-down and select Create Content Widget option.

• Add the title that will appear to your users. Create the content and use the text editor to customize. Once saved,
the widget will be added to your current tab. You can also select to make the widget transparent and without a
header. This option is disabled by default.

• Title Icons are available from the drop-down list. Each item will show the icon that will display next to the title.

• If linking the information to a website, you can list the URL title in the Title Link (External URL) field.
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Content Widget Improvements
Content Widget: Auto-Size

WFR-189642, WFR-196208: The Auto-Size Height checkbox has been added to the Create/Edit Content widget pop-up,
allowing users to define how they handle widget height. The checkbox is enabled by default, so auto-sizing is enabled by
default for new (Create Content Widget) and already existing Content widgets. The Auto-Size Height behavior works
with both the Regular Viewwith Header and the Transparent Viewwithout Header settings in the Content widget
configuration.

Tip: Auto size for the Content widget works when the tile is the full width of the Dashboard. It will not work, for
example, when the Content widget is 1 or 2 columns width because other tiles are in the row and impact its usage.

WFR-193663: When the Auto-Size Height checkbox is enabled, the full-width Content widget height in the Dashboard is
auto-sized according to content. Auto-sizing works for both transparent and regular Content widget versions.

The Adjust Size option is disabled (grayed out) when the Content widget is at full width and Auto-Size Height is enabled.
Full-width width can be 1 or 2 columns width depending on the device/screen resolution. If the Content widget width is
adjusted to not be full width, then the Auto-Size option is grayed out and is not applicable, and the last selected state still
appears.

When editing the dashboard schedule, and clicking the Content Widget tab, you can remove or edit the widgets using
the Configure and Remove buttons.

End User View

Adding entries will automatically create a Content Widgets tab in your dashboard profiles. When users click the tab, they
will see the entries you created. If users have permission to edit their widgets, the Add+ option will be available, and
users can add more widgets. They cannot create or add Content Widgets.

Content Widget: Copy Company

WFR-195180, WFR-184849: When using the Copy Company functionality, the Content widget is included in the new
company copied from the existing company. The Content widget is also included when using the Snapshots functionality.

Delete Previously Created Content Widgets

WFR-200711: Users who have access to the Content Widgets Library under Company Settings > Profiles/Policies >
Dashboard Layout > Content Widget Library can now delete Content widgets when given the appropriate security
permissions (View/Edit/Delete for theDashboard Layout Profile security item). A new column, Button: Delete, has been
added to the report by default. Users can delete a Content widget even when it is assigned to a Dashboard Layout Profile.

When the user clicks theDelete button, the following warning message appears:

"This action cannot be undone. Are you sure you want to delete Content widget settings?"

Content Widget Save Behavior

WFR-209332: The Save action for Content widgets now only saves the changes to the Content widget, and changes are
pushed to end users when a Dashboard Layout Schedule is Reset or scheduled for a Start Date.

• Upon the Reset/Start Date of a schedule inside a Dashboard Layout profile, the Content widget changes are
available to the end-users assigned to the Dashboard Layout profile.
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• If other Dashboard Layout profiles contain the same Content widget, the changes are not available to the end users
until the Schedules in those profiles are Reset or begin on a Start Date.

Preview Content Widget Output on Dashboard Layout Schedule
WFR-197230: Admins now have the option to preview the Content widget output on the Dashboard Layout Schedule.
The Edit Mode toggle is enabled by default anytime a user accesses the Dashboard Layout Profile configuration page.
When the Edit Mode toggle is enabled:

• The Configure and Remove buttons on the Content widget(s) are available.

• TheWidgets and Report/Chart tiles continue to be displayed as usual without the Edit Mode toggle.

When the Edit Mode is switched off:

• The Configure and Remove buttons are hidden on the Content widget(s). The Content widget output on the
Dashboard Layout Schedule page is based on the tile configuration.

• TheWidgets and Report/Chart tiles continue to be displayed as usual without the Edit Mode toggle.

Note: This behavior is not applicable to the end user Dashboard Layout Edit Mode.

Delivery Destinations

SFTP Failure Email Delivery Destinations in Data Exports and Deliver To
WFR-217911: Email Delivery Destinations that are linked to SFTP Delivery Destinations Failure Email Destinations have
been removed from Data Exports and the Report "Deliver To..." list of destinations.

SFTP Connection Enhancements
WFR-205123: The following enhancements have been made to the SFTP connections for SFTP Delivery Destinations.

• When testing a connection, there is now a 3 second wait before closing the connection if it is successful.

• Additional messages have been added based upon the type of failure returned by the server.

• The port number is automatically removed from the hostnamewhen saving or connecting.

• An error is shown when the port number is not in the valid range (1 to 65535).

Delivery Destinations Restrictions for Direct Companies on Data Exports
WFR-214652: To reduce errors/security violations, Delivery Destinations for direct client companies are now limited to
Delivery Destinations that are related to that specific company. This can include Delivery Destinations created by the
company or set to be visible for that client company by the Admin company. Companies using UKG Payroll Services will
also see the Delivery Destinations set up by the UKG Payroll Services Admin company and set to be visible for that client
company or Visible to All Companies.
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New! Employee Profile Redesign
**The functionality described below was already available for all customers. It was enabled the week of March
19th, 2021.**

Based upon your valuable feedback, the Employee Profile (My Team > Employee Information),My Profile and
Applicant Profile pages have has been redesigned to provide users with universally helpful features and functions
desired by customers. The redesigned workspace includes:

• A compact view that optimizes the Desktop experience to allowmultiple columns of widgets to be displayed,
thereby reducing scrolling.

• A flexible layout that allows users to close unused widgets.

• The ability to collapse the Jump To panel.

• A dedicated Profiles panel that persists across tabs to allow configuration of Profile fields while referencing other
contents on the page.

A Jump To Links panel now displays along the left hand side. A section with general widgets is positioned in themiddle of
the page, and Profiles now display on the right hand side.

Jump To Links (left panel)

This panel includes links that allow users to "jump to" specific sections/widgets within the center of the page.

• This also applies toMy Profile and the Applicant Profile.

• This section can be opened/expanded and closed/collapsed using the left/right arrow in the upper right hand
corner. When the section is collapsed, it can be accessed via the Jump To icon.

• Users can expand all widgets and collapse all widgets in the center section via the top link in this section (Expand All
or Collapse All). The selection a user makes (Expanded or Collapsed) is saved when the user leaves and then
returns to the system.

Widgets (middle section)

This section contains the applicable employee widgets, and no functional changes have been made to the widgets.

• This also applies toMy Profile and Applicant Profiles.

• The layout of this section can be 1, 2 or 3 columns based on:

• 1 column with the left and right panels collapsed (768-1280 px)

• 1 column with the left and right panels opened (1280-1680 px)

• 2 columns (1680-2560 px)

• 3 columns (2560 px and above)
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As the screen grows and additional columns are added, the widgets are displayed based on the order defined in Edit
Tabs. For example, if a user has Widget A, Widget B and Widget C listed as 1, 2, and 3 in the Edit Tabs, and they have 3
columns, then Widgets A, B, and C are all in the first row.

• Widgets can be expanded and collapsed, and the selection made by the user is saved across sessions.

• The width of a widget is determined by the number of columns and howmany widgets are expanded on a given
column.

Profiles Widget (right panel)

This panel includes the Profiles available to be assigned to employees.

• This is a new section/panel. The Profiles widget has been moved to the right panel.

• This section can be expanded and collapsed. When collapsed, users can expand the section via the Profile icon.

• The Profiles widget is enabled on a tab via the Show Profiles Panel checkbox on the configuration (Edit Tabs) page.

• Profiles are accessed via the Profile icon in the header in theMobile Application only.

Employee Profile Toggle between the Classic Look and the New Design
**The functionality described below was already available for all customers. It was enabled the week of March
19th, 2021.**

WFR-218798: Users can utilize a toggle to return back to the Classic view of the Employee Profile or to try out the new
look. When the Employee Profile screen is in the Classic mode, the toggle allows users to Try the New Look. When the
Employee Profile screen is in the redesigned view, the toggle allows users to go Back to Classic.

Note: The Try the New Look toggle will be removed during a future release.

Cost Center Widget: Hide Fields
**This functionality is only available in the multi-column (compact) Employee Profile view.**

WFR-214641: Admins/users with Edit access to the Employee Profile and Cost Center Widget (Custom Permissions are
applicable) and the ability to edit their tab configuration (Edit Tabs) can customize their widget to meet their own needs.
The Gear icon has been added to the Cost Center widget in Edit Tabs, and when selected, a dialog appears listing all of the
fields within the Cost Center widget with checkboxes next to them.

Dates Widget: Hide Fields
**This functionality is only available in the multi-column (compact) Employee Profile view.**

WFR-214644: Managers with Edit Access to the Employee Profile and Dates Widget can now customize the Dates widget
based on their own needs. Users can quickly locate their employee's Start Date, Birthday, etc. so they knowwhen to
complete their Annual Review and send them a company Birthday Card. Other dates associated with their accounts can
be hidden so it is not more difficult to quickly find the information they need. Users can only Hide/Unhide profiles they
have permissions to edit via the widget.
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Profiles Widget: Hide Fields
**This functionality is only available in the multi-column (compact) Employee Profile view.**

WFR-214642: Users with Edit Access to the Employee Profile and the Profiles Widget and the ability to edit their tab
configuration (Edit Tabs) can now customize the Profiles widget based on their own needs using the gear icon for the
Show Profiles Panel in Edit Tabs. Users can only hide/unhide profiles they have permissions to edit, and if a user does not
have security access to a particular profile, that profile option will not appear in the show/hide pop-up.

Upon selecting the gear icon, a dialog appears that lists all fields within the Profiles widget with a checkbox next to it. All
checkboxes are selected by default. If the checkbox is unselected, that field is no longer shown within the Profiles widget
of this user's profile. If a profile is required, it cannot be hidden. It will appear in the configuration dialog with the
checkbox selected (read-only) and a red asterisk next to the name.

Dashboard Header Configuration
**This enhancement only applies to the New UI Dashboard.**

WFR-217248: Users can view relevant information about themselves the header of their Dashboard. The following pieces
of information always appear in the header:

• Employee Photo (or placeholder photo)

• Employee Name

Up to 3 sections of employee information can be included in the header. The order of fields is determined by the order
they've been selected in via the configuration.

If one or more date options are selected, the date is reflected in the Company's date locale. If the user does not contain
information for the configured field, nothing displays for the field.

Employee Profile Header Configuration
**This enhancement only applies to the New Look Employee Profile (Single and Multi-Column).**

   WFR-217245: Users can view information about their employees that is relevant via the header in their Employee
Profile using settings in the Employee Header Configuration section in the Company Setup (Company Settings > Global
Setup > Company Setup).

Up to 3 sections of employee information can be included in the header. The information does not appear in themini
header. If one or more date options is/are selected, the date is reflected in the Company's date locale.

My Profile Header Configuration
**This enhancement only applies to the New Look Employee Profile (Single and Multi-Column).**

   WFR-217246: Users can view relevant information about themselves via the header in My Profile. The information
does not appear in themini header. The order of the fields is determined by the order they've been selected via the
configuration. If one or more date options is/are selected, the date is reflected in the Company's date locale.
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Default Selection Displays for Header
WFR-229315: Default selections now display for the Employee Profile, My Profile, and Dashboard fields in the Employee
Header Configuration section under Company Settings > Global Setup > Company Setup.

Employee Profile Mini Header Updates
WFR-189475: Updates have been made to the Employee ProfileMini Header that impact the following pages:

• Employee Profile

• My Profile

• Applicant Profile

• NewUI Dashboard

Look & Feel

Teal Color Theme Applied to Home Dashboard Widgets
WFR-209576: The newUKG Ready Teal theme is available in the Look & Feel (New UI) widget under Company Settings >
Global Setup > Look & Feel > System Themes. When selected and saved, your header will change to the UKG color
scheme.

In that Start widget, any icons selected from the standard system icons will also display with the Teal color theming.

WFR-203494, WFR-214335: The Dashboard Widget for the UKG Ready Teal theme has been added to the Look & Feel
page. The fields on the widget are prepopulated and non-editable, and the background image is changed to the new
color.

System Theme Support in Simple Look Ups and Selection Pop Ups
WFR-209428: When the Teal option is selected in the Theme drop-down from the Look and Feel (New UI) widget within
System Themes, the following elements are updated to align with the System Theme option:

• Simple Lookups which are not report-based: Table Header and buttons, highlighted rows (upon hovering and upon
selection)

• Dialog search (Selection Pop-up)

The updates are applied toManage Email Schedules > Company Groups and Annualized Projected Hours > Time Off
Lists.

System Theme Support in the e-Signature Audit Report
WFR-209443: The system now supports the newUKG Ready Teal System Theme on the e-Signature Audit Report page for
the following elements:
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• Header

• Hover

• Selected State

System Theme Support for Mobile (Offline mode, Reports)
WFR-212035: The buttons on dialogs in Offlinemode should align with the standard design, so that:

• The image with the user's initials displays when the user has no photo.

• Highlighting of EIN drop-down options is applied.

• The default UKG logo on tablets in Offlinemode is visible.

• The highlighting on reports/report-based lookups has been updated in accordance with the system theming
option.

• When a column filter is applied, the column background color is secondary.

System Theming Support for Toggle Button and TabsSet
WFR-216453: When the Teal option is selected in the Theme drop-down from the Look and Feel (NewUI) widget within
System Themes, the toggle button now displays in the appropriate color to match the theme. Additionally, for the
TabsSet, the color of the line above the selected tab is consistent with the Teal theme, including for theMy Mailbox tab.

Personalized Experience / readyConnect

Employee Birthday Redirect Change
WFR-218806: Users are now redirected to the Birthday calendar page when they select the Employee Birthday's Today
Task. When selected, the user is redirected to HR > Reports > Birthday Calendar by Week. The report is filtered by
today.

Events in My Topics Sorted Based on Priority
WFR-219946: Users can now see prioritized topics in My Topics so they will see themost important things first. Priorities
impact the order an Event/Topics appear(s) in the following areas:

• Dashboard CTA with Today's Task: Priority 1 appears as the first green pill, followed by priority 2 as the second
green pill, etc.

• Dashboard CTA without Today's Task: Priority 1 is the full Call to Action, Priority 2 is a green pill, etc.

• My Topics list (readyConnect): List reflects the priority order (i.e. Priority 1 is first, priority 2 is second, etc.)
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Unread Indicator in My Topics List
WFR-225683: Users can see the red dot indicator above the readyConnect header icon, so nowwhen they open theMy
Topics tab, there is an indicator identifying the topic(s) they have not yet viewed.

A blue dot indicator displays next to any event in theMy Topics list that has not yet been viewed by the user. The
appearance of the blue dot follows the same rules as the blue dot that appears in the Dashboard Call To Actions when an
event has not yet been viewed. Once the user views the topic, the blue dot no longer appears.

Platform

IMPORTANT! Right Click Support
WFR-230142: Navigation through right click mouse interactions may have unpredictable behavior based on the page or
link being accessed. This feature is native to the internet browser, and is not a standard feature within the product, so
the behavior may not be as expected at all times.

IMPORTANT! End of Life Plan for Internet Explorer 11
WFR-230143: In order to provide a modern and secure experience for our direct customers and partners, UKG Ready will
end support for IE11 after the April (R74) 2021 release. Although the browser will continue to work, like the traffic UKG still
sees from older versions of Internet Explorer, IE11will no longer be qualified within the release readiness process, and
IE11-specific defects will no longer be accepted.

Additional information can be found here: https://www.kronos.com/blogs/working-smarter-cafe/2021-3/what-
deprecation-microsoft-ie-11s-browser-means-ukg-ready-customers

Login Pages in Application
WFR-220796: In this release we are unifying the Login pages within the application so users, regardless of company type,
will see the same UKG branded Login page. If you have customized your logo, that will not be affected by the
consolidation effort and will still display. If you would like to change your logo, you can download UKG specific logos
within theMedia Kit on theUKGNewsroomBranding Site - located in the right panel of the page (or directly here.)
Instructions on changing your logos can be found in the Look & Feel section of theGlobal Setup User Guide.

Icon Updates in Application
WFR-200590: The Question Mark icon and Community Help logo have been replaced with a new Personal Experience
panel icon.

WFR-206003: The Live Chat icon has been updated to indicate if it is online (green dot) or offline (gray dot). Colors of the
dots may change depending on the color theme in use. The icon will not appear for mobile, but Live Chat can still be
accessed via the readyConnect icon.

Live Chat: Kronos Name Replaced
WFR-209615: When connecting to Live Chat, the Kronos name has been updated to the new company name of UKG, i.e.
UKG Global Support.
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Update New UI Preferences Widget
WFR-227808: The NewUI Preferences widget within the security profile (Company Settings > Profiles/Policies > Security)
has been updated to apply to theMobile Application specifically. The widget has been renamed Mobile Preferences.

• The EnableMobile option has been renamed Mobile.

• The Login Credentials (Mobile Only) has been renamed Login Credentials.

• TheMobile Punch Settings has been renamed Offline Punch Settings.

• Throughout the security items, NewUI Preferences has been updated to Mobile Preferences.

These updates also apply to the security profiles in an Admin company underMaintenance > Companies > Client
Resources > Global > Security Profiles. No change has been made to the existing functionality.

An informational icon next to the Offline Punch Settings reads: The following punch settings control the visibility of
punch options for offline mobile support and the clock widget (mobile device only) within the dashboard.

Padding Between Buttons and Inline Message in Report-Based Widgets
WFR-184989: In the report-based widgets such as the Timesheet Awaiting My Approval widget, in the NewUI Dashboard
there is padding between the buttons and inlinemessage, which improves the readability of these objects.

Support of Universal/Application Links
WFR-167467: Support of universal/application links to iOS and Android is now available. When a 3rd party application (i.e.
UltiPro mobile or browser) uses a platform (iOS/Android) to open an app link, the UKG Ready Mobile App is opened if
installed.

Reports

Row-Level Actions in Report/Chart Tiles
WFR-203082: Row-based actions that were previously not yet supported for certain reports when they were placed in
Report/Chart tiles are now supported. These columns no longer appear without the icons, and users can now execute a
particular action (i.e., Edit, View, Preview, etc.). Work is in progress to address any remaining not yet supported actions
in upcoming releases.

Prevent Overriding with Deletion Is Not Allowed Setting
WFR-148350: Users can prevent overriding views with theDeletion is not Allowed setting enabled. TheDeletion Is Not
Allowed setting has been renamed Deletion and Overwriting Is Not Allowed in Save View, Save ViewAs, and Edit (Save
View pop-up triggered via Manage Views/ Edit from My Saved Reports page).

If a user saved the viewwith theDeletion is not Allowed setting enabled, then the Save View action is grayed-out within
the report action popover.
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Dashboard Framework
Added Pay Period Profile Selector to Time Summary Report

WFR-218487: Previously, a filtering option to select a Pay Period profile in the Time Summary report was not available.

What's changed: A filter option is now available in the Time Summary report so that you can select a specific Pay Period
profile. The selector will include all Pay Period profiles in your company.

Note: For TLM Enterprise customers, the Time Summary report is currently only available inside the NewUI
Dashboard widget, Time Summary.

Security

Add Make Default for All Security Item to Permission Dashboard
WFR-208660: The security itemMake Default for All has been added to the security profile in the Sharing section on the
Dashboard tab. This item permits/restricts setting of the Company Default view for all users in the company.

TheDashboard Sharing andManage Company Type Views security options should also be enabled when enabling
Make Default for All. When the security itemMake Default for All is enabled, then the related checkbox is displayed
under the Shared With All radio button on the Save View... and Save View As... .
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Feature Retirements
The table below documents functionality that has been retired or is planned to be retired. This table will be updated as
needed with every system release.

Retirements History

Product or
Component

Feature Menu Path
User
Experience

Reason
Retirement
Date

TLM Classic
Timesheet
view

N/A All All timesheet users will be
switched to the New
Timesheet view, and the
Classic Timesheet view
will no longer be available.

June 2021

TLM Rules
Analysis
page

Team> Time >
Reports > Time
Allocation > Rules
Analysis andMy
Info > MyReports
> Time Allocation
> Rules Analysis

All This page will no longer be
supported.

June 2021

Platform Internet
Explorer 11
– End of
Support

N/A Platform In order to provide a
modern and secure
experience for our direct
customers and partners,
UKGReadywill end
support for IE11 after the
April (R74) release

April 2021

Scheduler Schedule
Table View

Team> Schedule
> Schedules

All This view is not user-
friendly. From any of the
views, Print Preview will
still be available, which
includes the same
information for printing
with additional options as
to which shifts should be
included in the printout.

April 2021

Scheduler Schedule
Overview
ByDate
Range

Team> Schedule
> Schedule
Overview

All This view is not user-
friendly. You will still be
able to bring in multiple
schedules via the
Summary By Employee
report, but not in a
schedule-like view.

April 2021
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